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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the CS+ IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX231 microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX231 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Description Document Title Document No.
Type

User's Manual Describes the technical details of the RSKRX231 User’s Manual R20UT3027EG
RSK hardware.

Tutorial Manual Provides a guide to setting up RSK RSKRX231 Tutorial Manual R20UT3028EG
environment, running sample code and
debugging programs.

Quick Start Provides simple instructions to setup the RSKRX231 Quick Start Guide R20UT3029EG

Guide RSK and run the first sample.

Code Generator Provides a guide to code generation RSKRX231 Code Generator R20UT3030EG

Tutorial Manual and importing into the CS+ IDE. Tutorial Manual

Schematics Full detail circuit schematics of the RSK. RSKRX231 Schematics R20UT3026EG

Hardware Provides technical details of the RX231 RX231 Group Hardware RO1UHO0496EJ

Manual microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVD Digital Versatile Disc

El Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

UsSB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.



http://www.digilentinc.com/index.cfm
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LENESANS

RSKRX231
RENESAS STARTER KIT

R20UT3030EG0100
Rev. 1.00
Aug 24, 2015

1. Overview

1.1  Purpose

This RSKis an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE

code generator plug in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with CS+

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3030EG0100 Rev. 1.00
Aug 24, 2015 RENESAS
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RSKRX231 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the CS+ IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the code generator plug in for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:

e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.

e ‘Debug’is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options, producing code suitable for release in a product.

Some of the illustrative screenshots in this document will show text in the form RXxxx. These are general
screenshots and are applicable across the whole RX family. In this case, simply substitute RXxxx for RX231

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-depth
information.

R20UT3030EG0100 Rev. 1.00 e
Aug 24, 2015 RENESAS




RSKRX231 3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction
In this section the user will be guided through the steps required to create a new C project for the RX231 MCU,

ready to generate peripheral driver code using Code Generator. This project generation step is necessary to
create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:
Windows™ 7 & Vista: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)" icon

e CS+ will show the Start Page. Use the
‘GO’ button to Create a New Project.

Create New Project

A new project can be created
A new project can also be created by reusing the file configuration registered to an existing project.

(reate New Multi-nnre Proiant
e In the ‘Create Project’ dialog, select | | CreateProject =]
‘RX’ from the ‘Microcontroller’ pull- _
Microcontroller: RX Iz‘
down.
e In the ‘Using Microcontroller’ list Using mycrocontroller
control, scroll down to ‘RX231' and #h (Search microcentroller) Update. .
expand the tree control by clicking ‘+'. §E R5F523172xA(100pin) » | | Product Name-R5F52318AcFP R
¢ in) W R5F523172¢L)(100pi On-chip ROM size[KBytes]:512
Select ‘R5F52318AxFP(100pin)’. g o SEMEI:)) | Onc R e s 5%

e Ensure that in the ‘Kind of project’ pull-
down, ‘Empty Application(CC-RX)’ is
selected.

e Choose an appropriate name and

location for the project, then click
‘Create’.

Note: this tutorial assumes the project
is named and located at the place
shown opposite.

e If the folder entered cannot be found a
‘Question’ dialogue will be displayed;
click 'Yes'.

----- Additional Information:Package=PLGPO100KE-A

F REF52318A:FP(100pin) il i

ek OCCCANA0ALL AN

Kind of project: Empty Application(CC-RX) IZ‘
Project name: CG_Tutoral
Flace: Cworkspace |Z|

Make the project folder

Cworkspace\CG_Tutorial\CG_Tutorial mip)

[ Pass the file composition of an existing project to the new project

w

Project to be passed: Browse...

Copy composition files in the diverted project folder to a new project folder.

Create l ’ Cancel ] ’ Help

R20UT3030EG0100 Rev. 1.00
Aug 24, 2015

RENESAS
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RSKRX231

3. Board Layout

previously enabled.

e CS+ will create the blank project with
the standard project tree. A ‘Code
Generator’ node may also be shown, if

Project Tree

: @ 38 &

Property

=-| 1% RSKRX231 Tutorial (Project)

.. 3% R5F52318AxFP (Microcontroller)
EJ Bsﬂ Code Generator (Design Tool)
E} Peripheral Functions

! E;J;{ Code Preview

.. A, CC-RX (Build Teol)

.55 RX E1(Serial) (Debug Tool)

En_’il File

D:__ﬂ Code Generator Property

4 Generate File Mode
Output folder
File generation control
Register files
Report type

4 Product Information
Release date

Version

R20UT3030EG0100 Rev. 1.00
Aug 24, 2015

RENESAS
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RSKRX231 4.  Code Generation Using the CS+ plug in

4. Code Generation Using the CS+ plug in

4.1 Introduction

Code Generator is a Windows™ GUI tool for generating template ‘C’ source code and project settings for the
RX231. When using Code Generator, the user is able to configure various MCU features and operating
parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the
Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called CG_Tutorial. A fully
completed Tutorial project is contained on the DVD and may be imported into CS+ by following the steps in
the Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK.

Following a tour of the key user interface features of Code Generator in 84.3, the reader is guided through
each of the peripheral function configuration dialogs in 84.4. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

4.2 Enabling Code Generator

After installation of CS+, Code Generator must be enabled. This step is only required once, CS+ will
remember this setting on subsequent launches.

From the ‘Tool' pull-down menu select ‘Plug-in Setting...”. On the ‘Additional Function’ tab, click the box next to
the ‘Code Generator/Pin View Plug-in’ option and ensure it is ticked:

Basic Function

Module Name Description

[ .} Code Ganerator Plug-n Plug4n to generate the device driver automatically for VB50, 7BKD, TBKOR, RL78/G12, G13, G1
CodeGawﬁoran\ﬁav Plug-n Plug-in to generate the device driver automatically and to view the device corfiguration for RX,

Click ‘OK’. CS+ needs to restart to enable this selection, select ‘Yes’ from the Question dialogue box.
After restarting, ‘Code Generator (Design Tool)' node will now be shown in the left-hand ‘Project Tree’ window

pane.
Project Tree 4 x
A [ [ ] r]
k4 \:? & 'E ':;:] Code Generator Property
=RV RSKR¥231 Tutorial (Project [ e e e
ERi7| Code Generator (Design Tool) Output folder
i [@-Eu Peripheral Functions File generation control
e ‘:f Code Preview Register files
A, CC-RX (Build Tool) Reporttype
iz RX EL(Serial) (Debug Tool) ‘ E[?d_"c“?m
-3 File e
R20UT3030EG0100 Rev. 1.00 RENESAS Page 11 of 54
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RSKRX231 4.  Code Generation Using the CS+ plug in

4.3 Code Generator Tour

This section presents a brief tour of Code Generator. For further details of the Code Generator paradigm and
reference, refer to the Application Leading Tool Common Operations manual.

You can download the latest document from: http://www.renesas.com/applilet

Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the
Code Generator.

In the Project Tree pane, click on the icon next to ‘Code Generator’ node to expand the list.

Expand the ‘Peripheral Functions’ node by clicking on the next to it.

Open the ‘Peripheral Function’ tab by double clicking on the ‘Peripheral Functions’ name.

The CS+ main window will now contain a ‘Peripheral Functions’ tab with the Initial View as show in Figure 4-1.

@3 C6_Tutorial - CS+ for CC - [Peripheral Functions] o l[®][(=
File Edit View Project Build Debug Tool Window Help
Bsat JEHE@ X biloo s o - & B DefaultBuilc <& Dy B
R NN
Project Tree 8 x [ Property | 5 Peripheral Functions™ | - [>¢]
: 02 @ P o " an 5 SR e B @ s s M A E] D D S om N 123
- | 5] GenerateCode | & O F E # MW A A DG OO O OL S S E TGS M
5. Bl Code Generator (Design Tool) - =
| Peripheral Functions Clock setting Blockdnamam\
i@ iClock Generatori VCC setting 4
4% Voltage Detection Circuit ® 27\ <VCC<55() %) 24 < MCC <27 (V) 9 18 < VCC <24 (V)
| Clock Frequency Accuracy N
\.w Low Power Consumption Main clock oscillator and SSI clock (SSISCK) setting
iw Interrupt Controller Unit /| Operation
4 Buses Main clock ascillation source Resonator -
oW 1O Ports E
i MHz)
1% DMA Controller i i 0
|® Data Transfer Controller Oscilltor wat tme B1%2cycles v 2048 (bs)
o
8. ek L Comtioie Qscillaton stop detection function Disabled =
4% Multi-Function Timer Pulse
|~ Port Output Enable 2 PLL circuit setting
4% 8-Bit Timer ] Ot
4w Compare Match Timer
4% 16-Bit Timer Pulse Unit Inout freauency division ratio x112 =
i~ Realtime Clock Output s
i Watchdog Timer ] -
| W Independent Watchdog Tim || 22519 Censcle Plug-iml E
| Serial Peripheral Interface Pul Ganrsqieades biug A i
i ene P Program Analyzer Plug-ing|
i CRC Caleulator IzonPythen Comscle Plug-im|
W Serial Communications Inte/ Stack Usage Tracery|
|% 12-Bit A/D Converter Update Manager Plug-in ¥
i 12-Bit D/A Converter All Messages %
el v'r b G Output & Error List
F1 Open Help for | |JF2 Rename TP Find Next |iP Replace text  |[[F& Go |[F& Buitd & Downlo.. [F7 Build Project |[F# lgnore Bresk = [FS&-;:"::r:’«ez,'m&:r 9 Siep In [ Jump to Function
B 1a DISCONNECT

Figure 4-1 Initial View

Code Generator provides GUI features for configuration of MCU subsystems and peripherals. Once the user
has configured all required MCU subsystems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Project Tree -> Project Name -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Project Tree -> Project Name -> Code Preview on the
left.

R20UT3030EG0100 Rev. 1.00
Aug 24, 2015
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RSKRX231 4.  Code Generation Using the CS+ plug in

4.4 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

4.4.1 Clock Generator

Figure 4-2 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 8 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation. The
PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-2.

R20UT3030EG0100 Rev. 1.00 RENESAS Page 13 of 54
Aug 24, 2015



RSKRX231

4.

Code Generation Using the CS+ plug in

zﬂ *Peripheral Functions 52 | [ Code Preview [ Properties

Clock setting | Block diagram

‘Cij Generate Code l'é]

-VCC setting
@ 27 (M <VCC<h5(V)

—Main clock oscillator and SS| clock (SSISCK) setting

Operation

D240 cVCC <27V

D180 cVCC <24V

Main clock oscillation source Resonator

Frequency a8 (MHz)

Oscillator wait time 2132 cycles - 2048 (us)

Oscillation stop detection function Disabled
- PLL circuit setting

Operation

Input frequency division ratio x1/2 -

Freguency multiplication factor %135 -

Freguency 54 (MHz)
- Sub-clock oscillator and RTC (RTCSCLEK) setting

Operation

Sub-clock cscillator drive capacity Drrive capacity for low CL

Freguency 32768 (kHz)
—High speed clock oscillator (HOCO) setting

[ Operation

Frequency 32 (MHz)
- Low speed clock oscillator (LOCO) setting

[ Operation

Freguency 4 (MHz)
- System clock setting

Clock source PLL circuit

System clock (ICLK) x1 - *.} (MHz)

Peripheral module clock (PCLKA) x1 - *.} (MHz)

Peripheral module clock (PCLKE) x1/2 - 27 (MHz)

Peripheral module clock for ADC (PCLKD) x1 - *.} (MHz)

External bus clock (BCLK) x 12 - 27 (MHz)

Flash IF clock (FCLK) x 12 - 7 (MHz)
- \WDT-dedicated low-speed cleck oscillator (WDTLOCO) setting

[ Operation

Freguency 15 (kHz)
- USB-dedicated clock (UCLK) setting

[] Operation

UCLK clock source USB-dedicated PLL clock

Frequency x3 43 (MHz)
- LPT clock (LPTCLK) setting

[7] Operation

Clock source Sub-clock oscillator

Frequency x1/2 16.384 (kHz)
— BCLK pin output setting

[7] Operation

Clock output source BCLK

CLKOUT pin setting

[7] Operation PE3

Clock output source Main clock oscillator

Freguency x 172 8 (MHz)

Figure 4-2 Clock setting tab

Proceed to the next section on Interrupt

R20UT3030EG0100 Rev. 1.00
Aug 24, 2015

RENESAS

Page 14 of 54



RSKRX231 4.  Code Generation Using the CS+ plug in

4.4.2 Interrupt Controller Unit

Referring to the RSK schematic, SW1 is connected to IRQ1 (P31) and SW2 is connected to IRQ4 (P34).
SW3 is connected to directly to the ADTRGOnN and will be configured later in 84.4.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge
triggered as shown in Figure 4-3 below.

" Property };.“&! Peripheral Functions ’

%] GenerateCode | % I S X # M L A O QDO DO

& & F A T Gt e 23

- Fast interrupt setting
[] Fast intemupt

Software interrupt setting

[T Software intemupt

BSC (BUSERR vect=16)

~NMI setting
[] NMI pin intermupt e Falling Mo filter ]
-IRG0 setting
[ IRan 30 L Mo filter 0
Low level Level 15 (highest)
-IRQ1 setting
IRQ1 Pin P31 - Digital fiter Mo filter 0
Valid edge  Falling - Priority  Level 15 (highest)
- IRQ2 setting
[ IRQ2 P32 Ma filter 0
Low level Level 15 (highest)
-IRQ3 setting
[E1 1RQ3 P13 Mo filter 0
= | Low level Lewvel 15 (highest)
- IRG4 setting
IRQ4 Pin P34 - Digital fiter Mo filter ~ |0
Valid edge  Falling - Prioity ~ Level 15 (highest) -

Figure 4-3 Interrupt Functions tab

R20UT3030EG0100 Rev. 1.00
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RSKRX231 4.  Code Generation Using the CS+ plug in

4.4.3 Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTO’ sub-tab configure CMTO as shown in Figure 4-4. This timer is configured to generate a High
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high

accuracy delays required in our application.

(=]l
S
"

L Property ‘fml Peripheral Functions®
B] GenerateCode | X O S X # M A A MD 0O DGODDHELLT TSI G S
CMTO | cMT1 | cMT2 | CMT3 |
Compare match timer operation setting

() Unused @ Used

m

Count clock setting -
@ PCLK/B @ PCLK/32 ) PCLK/128 © PCLK/512

Interval value setting
Interval value 1 ms » (Actual value: 1)
Interrupt setting
Enable compare match intermupt {CMIO)
Priority

Level 10 v

Figure 4-4 CMTO tab

Navigate to the ‘CMT1’ sub-tab and configure CMT1 as shown in Figure 4-5. This timer is configured to
generate a High priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

this tutorial.

£l Peripheral Functions™

Property
'f_ij Generate Code 'r!'—..
| cumo |} EMTT| cuT2 | cuT3 |

Compare match timer operation setting -
() Unused @ Used

= m o N
“‘|§ ;‘D ak Wi, "lf\ &

DEREBEEZRDADOABDEABAB TS

Count clock setting
@ PCLK/8 @ PCLK/32 @ PCLK/128 i©) PCLK/512

Interval value setting
Interval value 20 ms »  (Actual value: 20)
Interrupt setting
[¥] Enable compare match intemupt {CMI1)

Priority Level 10 -

Figure 4-5 CMT1 tab

Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-6. This timer is configured to
generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in

this tutorial.
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RSKRX231 4.  Code Generation Using the CS+ plug in
=B

™ Property i_k! Peripheral Functions® {
N m s it o
; ..;-F & i, 'gl'\ =

DA @ WSS d 00000008877

‘i‘

‘f_iJ Generate Code -,!;

[ cuTo | cMT1| CMT2 | CMT3 |

Compare match timer operation setting -
() Unused

m

@ Used

- Count clock setting -
© PCLK/B © PCLK/32 & PCLK/128 @ PCLK/512

- Interval value setting
200 ms =  (Actual value: 200.004267)

Interval value

- Interrupt setting -
Enable compare match intemupt (CMI2)
Priority Level 10

Figure 4-6 CMT2 tab

4.4.4 12-bit A/D Converter

Navigate to the '12-bit A/D Converter’ tab in Code Generator. Refer to the screenshot shown in Figure 4-7,
Figure 4-8 and configure the S12AD as shown. We will be using the S12AD in 12-bit one shot mode on the
ANOOO input, which is connected to the RV1 potentiometer output on the RSK. The conversion start trigger

will be via the pin connected to SW3.

Page 17 of 54
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4.  Code Generation Using the CS+ plug in

f] GenerateCode | % [ & (& & M B 5 5 22 @ & D O B Bl & & F I T G oo 2

General sefting | Window A setting | Window B setiing |

- 512AD operation setting

) Unused

- Operation mode setting

@ Used

@ Single scan mode

- Double trigger mode setting

() Group scan mods

() Continuous scan mode

@ Disable () Enable
-AD ion select
@ High-speed ) Low-cument
- Self diagnosis setting
Mode Unused -

- Disconnection detection assist setting

Use VREFHOx0

Charge setting

- A/D converted value count setting

Group A without priority

Mot restarted or continued due to Group A priority

@ Addition mode

) Average mode

- High-Patential reference voltage select
@ AVCCOo

) Intemal reference voltage

(©) VREFHD

() No reference voltage

- Low-Potential reference voltage select
@ AVSS0

—‘indow function setting

©) VREFLD

@ Disable

- Data storage buffer setting

() Enable

@ Disable

—Analog input channel setting

() Enable

g
2
El
o
2
5
z

ANODD
ANDOT
ANDO2
ANDO3
ANDD4
ANDDS
ANDDE
ANDOD7
ANDE
ANDTT
ANDB
ANDS
AND20
AND21
ANDZ22
ANDZ23
AND24
ANO25
AND26
AND27
AND23
AND23
ANO30
AND3T
Temperature sensoroutput ||

e

Intemal reference voltage D

]

Figure 4-7 A/D Converter tab-1

Add/Average AD value
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4.

Code Generation Using the CS+ plug in

—Conversion start trigger setting

Conversion start tigger (Group A)

AJD conversion start trigger pin

Conversion start tigger (Group B)

Compare match with or input capture to MTUD. TGRA

ADTRGH pin selection

— Data registers setting

PO7 -

AD converted value addition court

Data placement

Automatic clearing

Input sampling time

- ANDD1 conversion time setting
Input sampling time

- ANO0O0Z conversion time setting
Input sampling time

- ANDD3 conversion time setting
Input sampling time

—ANDD4 conversion time setting
Input sampling time

—ANOD5 conversion time setting
Input =ampling time

—ANDDE conversion time setting
Input sampling time

- ANDDT conversion time setting

Input sampling time

—ANOT6 - AND31 conversion time setting

Input sampling time

Input sampling time

Input sampling time

— Conversion time setting

1-time conversion

- Interrupt setting

Total conversion time (Group A)

Total conversion time (Group B)

Right-alignment -
Disable automatic clearing
—ANDDOD / Seli-diagnosis conversion time setting
3667 (s} (Actual value: 5)
[3.867 | s} (Actual value: 5}
[3.657 | =) (Actual value: 5)
[3.657 | =) (Actual value: 5)
[3.657 | ) (Actual value: 5)
[3.657 | =) (Actual value: 5)
[3.667 | s} (Actual value: 5}
[3.667 | s} (Actual value: 5)
[3.667 | =) (Actual value: 3.667)
- Temperature sensor output conversion time setting
[5 | =) (Actual value: 5)
- Internal reference voltage conversion time setting
[5 | =) (Actual value: 5)
4574 {us)
| | 6=
Enable AD conversion end intemupt (ADIT20)
Level 15 (highest) -

Priority

[¥] Enable AD conversion end interrupt for group B (GBADI)

Priority

[ Level 15 (highest) -]

Figure 4-8 A/D Converter tab-2
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RSKRX231 4.  Code Generation Using the CS+ plug in

4.4.5 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI8 sub-tab and apply
the settings shown in Figure 4-9. In the RSKRX231 SCI8 is used as an SPI master for the Pmod LCD on the

PMOD1 connector as shown in the schematic.

7 Property f*_k! Peripheral Functions
f] GenerateCode | 5 0 & [ # W 3B & 5 - D 0 DO O O & &S IE T S e 2

&,
| scio | sci | scis | scie | scig | scis | scinz |
General setting | Setting

Function setting
() Unused
() Asynchronous mode Transmission
() Asynchronous mode (Mutti-processor) Transmission
(7) Clock synchronous mode Transmission
() Smart card interfface mode Transmission
() Simple IIC bus
@ Simple SP1bus Master transmit only -
- Pin setting
PET RXDS PCE
PCY SSCL PCB
SMosI8  PCT - SMISOE FCB .

Figure 4-9 SCI8 General Setting tab

Select the SCI8 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-10. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 6750000. All other settings remain at
their defaults.

R20UT3030EG0100 Rev. 1.00 RENESANAS Page 20 of 54
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4.  Code Generation Using the CS+ plug in

T Genentecode (2 0 EE FBBEEZ DO D DO

@ @ F I T b % e 2

| scio | scit | scis | scie | Sci8 | scig | sciz |

|General setting| Setting ‘

- Data handling setting

[7] Enable clock polarity inversion

- Transfer direction setting
() LSBHirst @ MSBHirst
- Data inversion setting
@ Nomal ) Inverted
- Transfer rate setting
Transfer clock Internal clock + PCH -
Bit rate 6750000 v bps)  (Actual value: 6750000, Ermor ; 0%)
[] Enable modulation duty comection
SCKB8 pin function selection Clock output v
- Clock setting
Clock delay Clock is not delayed -

Transmit data handling

- Interrupt setting

Data handled in interrupt service routine

TXI8, TEIS prionty

- Callback function setting

Level 15 (highest) -

Transmission end

Figure 4-10 SCI8 SPI Master Setting

Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI5 sub-tab and apply the
settings shown in Figure 4-11. In the RSKRX231 SCI5 is connected via a Renesas RL78/G1C to provide a
USB virtual COM port as shown in the schematic.

G Genertecode | £ 0 B ¥ WMBASLLDAD OO

BB S & T b el B

scio | sci | SCIs | scie | scis | scia | sci2 |

General setting | Setting [

- Function setting

) Unused

@ Asynchronous mode

(2 Clock synchronous mode

() Smart card interface mode

() Asynchronous mode (Multiprocessar)

Transmission/reception -
Transmission
Transmission -

Transmission

() Simple IIC bus
) Simple 5P bus Slave transmitreceive
- Pin setting
TXD5 PA4 RXD5 PA3 -
DA PA4 ssCL5 [ PA2

Figure 4-11 SCI5 General Setting tab

R20UT3030EG0100 Rev. 1.00
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RSKRX231 4.  Code Generation Using the CS+ plug in

Select the SCI5 ‘Setting’ sub-tab and configure SCI5 as illustrated in Figure 4-12. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD5 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings
remain at their defaults.

%] GenerateCode | = O & - @ M m 2 2 O M OO E
| scio | sci | SCi5 | scie | scie | sci9 | sciz |
|Generai setl:ing| Setting |

& F T G g eE 2

- Start bit edge detection setting

() Low level on RXD5 pin @ Falling edge on RXD5 pin
- Data length setting

) 9bits @ 8 bits () 7 bits
- Parity setting

@ None ) Even ) Odd
- Stop bit length setting

@ 1bit @ 2bits
- Transfer direction setting

@ LSBHirst () MSBirst
- Transfer rate setting ,

Transfer clock Internal clock v PA1

Bit rate 15200 - bps) (Actual value: 15176.136, Emor: -0.1243%)

["] Enable modulation duty comection

SCK5 pin function SCK5 is not used -
- Noise filter setting

[7] Enable noise fitter

Noise filter cloch Clock signal divided by 1 | 27000000 | (Hz
- Hardware flow control setting

@ None @ CTS ) RTS

CTS5/RTSS pin A6
- Data handling setting

Transmit data handling Data handled in interrupt service routine -

Receive data handling Data handled in interrupt service routine -

-~ Interrupt setting
Enable emor intemupt (ERIS)

Figure 4-12 SCI5 Asynchronous Setting
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RSKRX231 4.  Code Generation Using the CS+ plug in

4.4.6 I/O Ports

Referring to the RSK schematic, LEDO is connected to P17, LED1 is connected to P50, LED2 is connected to
P51 and LED3 is connected to P52. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four I/O lines as shown in Figure 4-13 and Figure 4-14 below. Ensure that the ‘Output 1’ tick box is checked.
This ensures that the code is generated to set LEDs initially off.

Property .‘2,,_:‘! Peripheral Functions asm
] GenerateCode | % [0 & R & ¥ S8 &5 o5 2= @ 0 D D @ 0 @ & F L F G * M o 2
| Portd | Portl | Port2 | Port3 | Port4 | Port5 | PortA | PortB | PortC | PortD | PortE | Portd |

@ Unused @ In ) Out Pull-up ‘ CMOS output g Qutput 1 || High-drve output
-P13

@ Unused (@R ©) Out | Pullup | CMOS output v| | Output 1 High-drive output
-P14

@ Unused ) In ) Out Pull-up ‘CMDS output . | | Output 1 " | High-drive output
-P15

@ Unused @ In @ Out Pulup | CMOS output | Outpuit 1 High-drive output
-P16

@ Unused @ In @ Out Pull-up | CMOS output | [ ] Output 1 | High-drive output
=PI

) Unused @ In @ Out Pull-up CMOS output - Output T[] High-drive output

Figure 4-13 1/O ports — Portl

‘@]GenerateCo-de ﬂgﬁ&-ﬁéﬁﬁ%%m@&@@@
| Port0 | Portl | Port2 | Port3 | Port4 | Port5 | PortA | PortB | PortC | PortD | PortE | Portd |

BB ST b S

- P50

() Unused @ in @ Out P CMOS output - Output 1 [T High-drive output
- P51

() Unused 2 n @ Out | Pullup CMOS output * Output 1 [T] High-drive output
L

() Unused @ In @ Out [ ] Pull-up CMOS output - Output 1 [] High-drive output
-P53

@ Unused @ In () Out [ Pull-up | Output 1 High-drive output
-P54

@ Unused @ In @) Out [] Pull-up CMOS output v [ ] Output 1 High-drive output
~Phb

@ Unused i n @ Out Pullup [] Output 1 High-drive output

Figure 4-14 1/O ports — Port5
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RSKRX231 4.  Code Generation Using the CS+ plug in

P33 is used as one of the LCD control lines, together with PE3, PE4 and PE7. Configure these lines as shown
in Figure 4-15,.Figure 4-16

%] GenerateCode | 2 O S E W W S S DA DO DE L LTI T b M

| Portd | Port1 | Port2 | Port3 | Portd | Port5 | PortA | PortB | PortC | PortD | PortE | Portd |

-F30

@ Unused ) In ) Out [] Pullup ICMOS output -v] [10output1 [ High-drive output
~P31

@ Unused ®h® &ouw® []Pulu |CMOSoutput v\ [] ouwput 1 [] High-drive output
P32

@ Unused ® In ) Out [] Pullup [CMDS output v} (] Output 1 [] High-drive output
P33

) Unused @ In @ Out ] Pullup CMOS output - Output 1 High-drive output
-P34

@ Unused ©®h@® ©®0uw® [JPiup |CMOSoutput -] (] output 1 [ High-drive output
=Pa5

@ Unused @ In
_P3

@Uused ©Oh @ ©O0uw ® [JFiuw  |CMOS output - ] Output 1
-P37

@ Unused Oh® @O0t ® [JPuuwp  [CMOSoutput - ] Output 1

Figure 4-15 1/O ports — Port3

E’;’]Generate{:ode f- lal &“E—#ﬂﬁ;%%ﬁ@@@@@ T
| Portd | Port1 | Pori2 | Port3 | Port4 | Port5 | PortA | PortB | PortC | PortD | PortE | Portd |

& F I F G e 2

~PED

@ Unused ® In © Out (] Pulup | CMOS output -| (] Output 1 [] High-drive output
-PE1

@ Unused @ In O Out (] Pulup | CMOS output -| CJouput1 [ High-drive output
-PE2

@ Unused @ In ) Out (] Pulup | CMOS output v [] Output 1 [] High-drive output
-PE3

() Unused @ In @ Qut [] Pull-up CMOS output - Output 1 High-drive output
_PE4

() Unused @ In @ Out [] Pullup CMOS output - [[] Output 1 [ High-drive output
-PE5

@ Unused @ In © Ot [] Pulup | CMOS output v| [(Joutput 1 [] High-drive output
- PE6

@ Unused ® In ® Out (] Pulup | CMOS output - [ Output 1 [] High-drive output
-PE7

) Unused @ In @ Out [] Pullup CMOS output - Output 1 High-drive output

Figure 4-16 1/O ports — PortE
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RSKRX231 4.  Code Generation Using the CS+ plug in

Peripheral function configuration is now complete. Save the project using the File -> Save Project menu item,
then click ‘Generate Code’. The Output pane should report ‘The operation of generating file was successful’,

as shown Figure 4-17 below.

Output

[X|

M0403002:The generating source folder is: C:\wnrkspace\CG_Iutnrial\g
M04053001:The following files were generated:J
M04059004:cg_srchr_cg main.c was nverwzitten.J
M0409004:cg_srchr_cg dbsct.c was nverwritten<d
M0405004:cg_src\r_cg_intprg.c was overwritten..]
M0409004:cg_srch\r_cg resetprg.c was cverwritten.g
M0409004:cg_srehr_cg sbrk.c was nverwzitcen.J
M0409004:cg_srchr_cg vecttbl.c was Dverwritten.d
M0409004:cg_srchr_cg sbrk_h was nverwritten_g
M0409004:cg srch\r_cg_ stacksct.h was nverwritten_g
M0409004:cg_srchr_cg vect.h was nverwritten.g
M0409004:cg_sreh\r_cg hardware setup.c was overwritten.g
M0409004:cg_src\r_cg macrodriver.h was overw:itten.g
M0409004:cg_srch\r_cg userdefine.h was overw:ittenAQ
M0408004:cg_srchr_cg_cgc.c was nverwritten.g
M0405004:-cg_srchr_cg cgc user.c was nverwritten_g
MO0405004:cg_srch\r_cg cgc.h was Dverwritten.J
M0405004:cg_srchr_cg icu.c was Dverwritten.d
M04035004:cg_srch\r_cg_icu user.c was overwrittenAJ
M0403004:cg_sre\r_cg_icu.h was cverwritcen‘g
M0403000:cg_srch\r_cg_port.c was generated.J
M0409000:cg_sreh\r_cg port user.c was genezated.J
MO0409000:cg_srchr_cg port.h was generated.d
M0409004:cg _srch\r cg cmt._c was nverwritten_g
M0409004:cg_srch\r_cg_cmt user.c was nverwritten_g
M0409004:cg_srehr_cg cmt.h was nverwxitcen.g
M0409000:cg_sreh\r_cg sci.c was generated.g
M0409000:cg_sre\r_cg sci_user.c was generated‘g
M0409000:cg_srchr_cg sci.h was generated‘J
M0403004:cg_src\r_cg_slZad.c was nverwzitten.g
M0403004:eg_srehr_cg slZad user._c was nve:written_g
M0405004:cg_srce\r_cg_slZad.h was nverwritten.J
HM0405003:The operation of generating file was successful.J
[EOQF]

m

‘ All Messages J.{ *Code Generator ,{ *Rapid Build /

Figure 4-17 Code generator console

R20UT3030EG0100 Rev. 1.00 RENESANAS
Aug 24, 2015

Page 25 of 54



RSKRX231

4.  Code Generation Using the CS+ plug in

Figure 4-18 shows the Code Generator Files in the Project Tree pane. In the next section the CG_Tutorial
project will be completed by adding user code into these files and adding new source files to the project.

Project Tree

@ 2 &

(X

Eﬂﬁ CG Tutorial (Project)*

. % R5F52318AxFP (Microcontroller)
- "5 Code Generator (Design Tool)
4, CC-RX (Build Tool)
é,a RX Simulator (Debug Tool)
=3 File
gﬂ Build tool generated files
B iodefine.h

‘-'_;,_l r_cg_main.c
‘-'_:_I r_cg_dbsct.c
CL:;I r_cg_intprg.c
E__] r_cg_resetprg.c
..... €| r_cg_sbrk.c
c_] r_cg_vecttbl.c
----- 6_—' r_cg_hardware_setup.c
iE_J r_cg_cgc.c
& r_cg_cgc_user.c
& r_cg icuc
& r_cq_icu_user.c
ﬂ r_cg_cmt.c
& r_cg_cmt_user.c
& r_cg sl2ad.c
8| r_cq_s12ad_user.c
=] r_cg_sbrk.h
‘_I;' r_cg_stacksct.h
-] r_cg_vecth
b= r_cg_macrodriver.h
t] r_cg_userdefine.h
. r_cg_cgeh
‘j_| r_cg_icu.h
M| r_cg_emt.h
t‘ r_cg_sl2ad.h
IE_[ r_cg_port.c
-.&| r_cq_port_user.c
& r_cg_scic
& r_cg_sci_user.c

41 -

¥

m

Figure 4-18 Code Generator Files in the Project Tree
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5. Completing the Tutorial Project

5. Completing the Tutorial Project

5.1

Project Settings

A, CC-RX Property

e In the ‘Project Tree’' pane, select | > - =
‘CC-RX (Build Tool). The build LR DefautBuid
. . . . 4
properties will appear in the main Instction set archilectuas b2 architecturelsamn2)
. Uzes floating-paint. operation instructions Yes|-fpu)
WIndOW Endian typegfnpr data ’ L\llla—:ndian datal-endian=little)
. . Rounding method for floating-point constant operations round to nearest-raund=nearest)
] CS+ creates a Slngle bulld Handling of denomalized numbers in foating-point constants Handles as zeros|-denormalize=off]
. . ¢ T Precision of the double type and long double type Handles in single precision|-dbl_size=4]
configuration called ‘Default Build Replaces th i pa with e sho ype. .
for the project. This has standard St o hsebe e
imi I Selects the enumeration type size automaticall Mo
COde Optl m IS&tIOﬂ turned on by Order of bit-field members 4 ' Allacates from right{-bit_order=right)
Assumes the boundary alignment value far structure members is 1 No[-unpack)
erault.
Enables C++ exceptional handling function [try, catch and throw)] Mo[-nioexception)
Enables the Ct+ exceptional handing function (dynamic_cast and typeid) Mo tti=off)
General registers used only in fast intermupt functions None{-fint_register=0]
Branch width size Compiles within 24 bits(-branch=24)
Base register for ROM None
Base register for RahM None
Address value of base register that sets the address value 00000000
Register of baze register that sets the address value None
Build mode
Selects the build mode name to be uzed during build,
e Select the ‘Compile Options’ tab at | °“'°" s . £99(1ang-cS8)
. . ariguage of § rce file -lang=c
the bottom of the properties window Lanquage of the Ce+ source fle CiCoSanga)
pane_ Under ‘Language Of the C > Additional include paths C
HPN] f _ f > System include paths pa
source flle SeleCt ng('lang_cgg) > Include files at the head of compiling units Include files at the head of con
as shown opposite_ > Macro definition Macro defirition[0]
Irealidates the oredefined macro
e Select the ‘Link Options’ tab at the | ¢ Optimization y y
b f th ti ind Optimization type Mo optimize[-MOO0Ptimize)
ottom of the properties Window | , section
pane. Under ‘Section -> ROM to Section start address B_1.A_1.B_2A_2B.R5U,5/04 PResetPRG OFFFFB000,C_1.C
i ’ > The specified zection that outputz  The specified section that outputs externally defined symbolz to th
RAM mapped section’, add the Lo spee i 0
. > Sechion alignment echion alignment
three  mappings as  shown RiOM to FM mappe ROM to RAM mapped section[3] =
0pp05|te. [0 D=R
1] D_1=R_1
[2] D=k &
. Thes_e settings are easily added _by Text Edit B
clicking the button *..." and pasting Text
the following text into the dialog: =
D_1=R_1
D_2-R_2
D=R
D 1=R 1
D 2=R 2
e This ensures that the linker assigns
RAM rather than ROM addresses
to C variables.
4 b
0K || Cancsl || e

R20UT3030EG0100 Rev. 1.00

Aug

24,2015

RENESAS

Page 27 of 54




RSKRX231 5. Completing the Tutorial Project

=

e From the ‘_BU|Id’ r’nenu_, se‘lect ‘_Bmldl Build Mode Settings @
Mode Settings...’. Click ‘Duplicate
and in the resulting ‘Character Selected buid mode:
String Input’ dialog, enter ‘Debug’ |
for the name of the duplicate build

mode. Build mode list:

e

e The new ‘Debug.’ build mO(_:ie will _be A, CC-RY Propetty E][
added to the Build mode list. Click 2 Build Mode
‘Close’. Now, in the main CC-RX (Buildmode e =
Property window, under the 4 OutputFile Type and Path
‘Common Options’ tab, click on the Output file type
line containing ‘Build Mode’, click Intermediate file output folder

the pull-down arrow and select
‘Debug’ from the pull-down’.

e Inthe ‘Frequently Used Options (for | A comxPropert @ (& =

) s 4 BuildMode
Compile) group, select the Build mode Debug

‘Optimization Level’ option and b CPU

select ‘0O’ from the pull-down. We | | " PIC/FD
4 Output File Type andPath

ha.Ve now CreatEd a ‘Debug, bu"d Output file type Execute Module[Load Module File]
mode W|th no Code Optimisation Intermediate file output folder #Buildd adeM ame?;
. . . 4 Frequently Used Options{for Compie]
and will be using the Build mode to b Addtional include paths Additional include paths[2]
create and debug the project. [+ Syztem include paths System include paths[0]
> Macro definition Macro definition[0]
Outputs debugging information “Y'es[-debug]

Optimization level 0[-optimize=0) El
Outputs additional information for inter-module optimization
Optinization type 1[-optimize=1]
Outputs a zource list file 2[-optimize=2)
4 Frequently Used Dptions{for Assemble] Mz -optimize=rmax)
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e All of the sample code projects
contained in this RSK are
configured with three Build modes;
‘DefaultBuild’, ‘Debug’ and
‘Release’. ‘Release’ is created in
the same way as above; by
duplicating ‘Default Build'.
‘Release’ build mode leaves code
optimisation  turned on and
removes debug information from
the output file.

e To remove debug information from
the ‘Release’ build mode, in the
‘CC-RX Property’ window, select
the ‘Common Options’ tab at the
bottom of the window pane. For
the ‘Outputs debugging information’
option, select ‘No(-nodebug).

e Reset the build mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

e From the menus, select ‘File ->

A

v vV h

"\ CC-Rx Property E] E][
BuildMode
Build mode Debug
CPU
PIC/PID
DOutput File Type andPath
Output file type Execute ModulelLoad Module File)
Intermediate file output folder *Buildt odeM ame?:
Fi Iy Used Dptions{for Compie]
Additional include paths Additional include paths[2]
Syztem include paths Syztem include paths[0]
M acro definition M acro definition[0]
Outputs debugging information Ho[-nodebug]
Optimization level

v T T T R

Outputs additional information for inter-module optimization
Optimization type

Outputs a source list file

F Iy Used Options{for A hle)

Additional include paths

System include paths

Macro definition

Frequently Used Options[for Link)

Using libraries

Outputs debugging information

Mal-noliztfile]

Additional include paths [0]
System include paths [0]
facro definition [0]

Using libraries[0]
ez [Outputs to the output file][-DEBug)

Outputs debugging information
Selects whether to output debugging information.
Thiz comesponds to the -debug and -nodebug options of the compiler.

Save AlI' to save all project
settings.
5.2 Additional Folders

e Before new source files are added
to the project, we will create two
additional folders in the CS+
Project Tree.

¢ In the Project Tree pane, right-click
the CG_Tutorial project and select
‘Add -> Add New Category’.

CG_Tuterial - C5+ for CC - [Project Tree]
File Edit View Project Build Debug Tool Window Help

Bostort |[[BH G X B0 o[58 B ~ %3 G Defauitt
D280 5
Property |5 Peripheral Functions”
A =
& =1
: S '2 & I"“_ﬁ CG_Tutorial Property
=2 0 . -
RoFE 518 P ]:J Build CG_Tuterial
Code Generat{ I] Rebuild CG_Tutorial Eolute path
4, CC-RX (Build L4 Clean CG_Tutorial pes
e RX Simulator
:ﬂ File ZL COpen Folder with Explorer
Bl Windows Explorer Menu
| Add >| 5 Add Subproject...

ff4 Set CG_Tutorial as Active Project +j’§ Add Mew Subproject...

Save Project and Development Tools as Package... _J Add File...
) Paste Cirl+V 5':'5] Add New File...

8@ Rename F2 |i:-:5_ Add New Category

e Rename the newly-created ‘New
Category’ folder to ‘C Source Files'.
Repeat these steps to create a new
category folder for ‘Dependencies’.

EI,_ﬁ CG Tutorial (Project)®

{E R5F52318AxFP (Microcontroller)

- DJ Code Generator (Design Tool)
.4, CC-RX (Build Tool)

iz RX Simulator (Debug Tool)
=3 File

.ﬂ Build tool generated files
._]_ Code Generator

_]_ C Source Files
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Locate the files ascii.h, r_okaya lIcd.h, iodefine.h,
ascii.c, and r_okaya_lcd.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder.

e Right-click on the ‘C Source Files’ | -3 File
in the Project Tree and select ‘Add - £ Build tool generated files
> Add File...’. | Code Generator

e Browse to the files ascii.c, and i....]) Dependen Add 3 Addrie.

r_okaya_lcd.c in the B Ooen Folder with Exol #] Add New Fil

H Ulpen Folder with exXplorer ™ ew rile...

C:\Workspace\CG_Tutorial  folder s —pen rolderwiih Spors _

and click ‘Add’ =) Windows Explorer Menu 1) Add New Category
e Repeat the above steps to add the & Remove from Project  Shift+Del

iles ascii.h , r_okaya_lcd.h to the iy Copy Ctrl+C

fil h , r_okaya lIcd.h to th 3 Copy

‘Dependencies’ folder. &l paste Cirl+V

e Repeat the above steps to add the
file iodefine.h to the ‘File’ folder.

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.
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/* Start user code for global. Do not edit comment generated here */
#define TRUE @)

#define FALSE ()

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, open the file ‘r_cg_main.c’ by double-clicking on it. Insert #include "r_okaya_lcd.h" in
between the user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSKRX231 ');
R_LCD_Display(1l, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
{
/* End user code. Do not edit comment generated here */
3
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in 84.4.5. In
the CS+ Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the user
code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI8_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci8_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI8:

static void r_sci8_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
sci8_txdone = TRUE;
/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/

* Function Name: R_SCI8 SPIMasterTransmit

* Description : This function sends SPI8 data to slave device.
* Arguments : tx_buf -

* transfer buffer pointer

* t>x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI8_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci8_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI8_SPIl_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci8_txdone)

/* Wait */
}

return (status);

* N

End of function R_SCI18 SPIMasterTransmit

/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.4.3. Open the file r_cg_cmth
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt() function and insert the following line in the user code area:

static void r_cmt_cmiO_interrupt(void)

{
/* Start user code. Do not edit comment generated here */
one_ms_delay_complete = TRUE;
/* End user code. Do not edit comment generated here */
3

Then insert the following function in the user code area at the end of the file:

Function Name: R_CMT_MsDelay

Description : Uses CMTO to wait for a specified number of milliseconds
Arguments : uintlé_t millisecs, number of milliseconds to wait
Return Value : None

X X ok T~

void R_CMT_MsDelay (const uintl6_t millisec)
uintl6é_t ms_count = O;

do
{
R_CMTO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

(o)

R_CMTO_Stop();
one_ms_delay complete = FALSE;
ms_count++;

3} while (ms_count < millisec);

3
/

End of function R_CMT_MsDelay

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSKRX231
Tutorial Press Any Switch on 3 lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Locate the files rskrx231ldef.h, r_rsk _switch.h and
r_rsk_switch.c in this folder. Copy these files into the C:\\Workspace\CG_Tutorial folder. Import these three
files into the project in the same way as the LCD files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.4.2 and 84.4.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

54.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_icu.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */
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Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

Function Name: R_ICU_IRQIsFallingEdge

Description : This function returns 1 if the specified ICU_IRQ is set to
falling edge triggered, otherwise O.

Arguments  uint8_t irg_no

Return Value : 1 if falling edge triggered, O if not

o oX X XN

uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0xO0;
iT (ICU.IRQCR[irg_no]-BYTE & _04 I1CU_IRQ_EDGE_FALLING)

falling_edge_trig = 1;
3

return falling_edge_trig;

N

End of function R_ICU_IRQIsFallingEdge

Function Name: R_ICU_IRQSetFallingEdge

Description : This function sets/clears the falling edge trigger for the
specified ICU_IRQ.

Arguments : uint8_t irg_no
uint8_t set_f edge, 1 if setting falling edge triggered, O if
clearing

Return Value : None

*ox % ok o XN

/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)

ifT (1 == set_T _edge)
ICU. IRQCR[irg_no].BYTE |= _04 ICU_IRQ_EDGE_FALLING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~ 04 ICU_IRQ EDGE_FALLING;
}

}
/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X F N\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irg_no].BYTE |= _08_ICU_IRQ EDGE RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING;

* NS

End of function R_ICU_IRQSetRisingEdge

R20UT3030EG0100 Rev. 1.00 RENESANAS Page 35 of 54
Aug 24, 2015



RSKRX231 5. Completing the Tutorial Project

Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_icu_irg4_interrupt ():

/* Switch 2 callback handler */
R_SWITCH_IsrCallback2();

In the same file insert the following code in the user code area inside the function r_icu_irgl_interrupt ():

/* Switch 1 callback handler */
R_SWITCH_IsrCallbackl1();

5.4.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();

In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT2_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCal lback();

5.4.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 84.4.4, we configured the ADC to be triggered from the ADTRGO# pin. In this code,
we also perform software triggered A/D conversion from the user switches SW1 and SW2, by reconfiguring
the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (¢D)
#define FALSE )

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */
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Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ);

/* Initialize the debug LCD */
R_LCD_InitQ);

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)"™ RSKRX231 ");

R_LCD Display(1, (uint8_t *)'" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)

/* End user code. Do not edit comment generated here */

¥
In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch _press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */
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Next add the highlighted code below in the user code area inside the main() function and the code inside the

while loop, resulting in the code shown below:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_Init();
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init ;
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)"™ RSKRX231 ");
R_LCD_Display(1, (uint8_t *)" Tutorial ");
R_LCD _Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD_Start();
while (1U)
{
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
iT (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else If (TRUE == g_adc_complete)
{
/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
/* do nothing */
}
/* End user code. Do not edit comment generated here */
3

Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code

area for adding at the end of the file, as shown below:
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Function Name : cb_switch_press

Description : Switch press callback function. Sets g_adc_trigger flag.
Argument > none

Return value : none

L R I N

static void cb_switch_press (void)

/* Check if switch 1 or 2 was pressed */
ifT (g_switch_flag & (SWITCHPRESS_ 1 | SWITCHPRESS_2))

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0xO0;

N

End of function cb_switch_press

Function Name : get_adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument I none

Return value : uintl6_t adc value

% F % % F N

static uintl6_t get _adc (void)

/* A variable to retrieve the adc result */
uintl6_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD_Stop();

/* Start a conversion */
R_S12AD0O_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)

/* Wait */
}

/* Stop conversion */
R_S12ADO_SWTriggerStop(Q);

/* Clear ADC flag */
g_adc_complete = FALSE;

R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */

R_S12AD_Start();

return adc_result;

}
/

* End of function get_adc

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintl6_t adc result

Return value : none

XX X o EN

static void lcd_display_adc (const uintl6_t adc_result)

{

/* Declare a temporary variable */
uint8_t a;
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/* Declare temporary character string */
char Icd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & O0xOF00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & 0x00F0) >> 4);

Icd_buffer[7] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)(adc_result & O0x000F);

Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd_buffer */
R_LCD_Display(3, (uint8_t *)lcd_buffer);

* N -

End of function lcd_display_adc

/

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the in the user code area for
function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12ADO_SWTriggerStart(void);

void R_S12AD0O_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.c’ by double-clicking on it. Insert the following code in the in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_S12ADO_SWTriggerStart

Description : This function starts the ADO converter.
Arguments : None

Return Value : None

L T R N

void R_S12ADO_SWTriggerStart(void)
{

IR(S12AD, S12ADIO) = OU;
IEN(S12AD, S12ADI0) = 1U;

S12AD.ADCSR.BIT_ADST = 1U;
3

/
End of function R_S12AD0 SWTriggerStart

Function Name: R_S12ADO_SWTriggerStop

Description : This function stops the ADO converter.
Arguments : None

Return Value : None

Ok Ok XN

void R_S12ADO_SWTriggerStop(void)
{
S12AD.ADCSR.BIT.ADST = 0U;

IEN(S12AD, S12ADIO) = OU;
IR(S12AD, S12ADI0) = 0U;
3
/
End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */
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Open the file r_cg_sl12ad_user.c and insert the following code in the in the user code area for global, resulting
in the code shown below:

/* Start user code for global. Do not edit comment generated here */
/* Flag indicates when A/D conversion is complete */

volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_s12ad_interrupt () function, resulting in the code shown
below:

static void r_sl2ad_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

}

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the CG_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Locate the files r_rsk _debug.h and
r_rsk_debug.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI5_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_sci.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI8_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI5_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci8_txdone;
static volatile uint8_t sci5_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_sci5_callback_transmitend()
function:

static void r_sci5_callback_transmitend(void)

{
/* Start user code. Do not edit comment generated here */
sci5_txdone = TRUE;
/* End user code. Do not edit comment generated here */
3
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In the same file, insert the following code in the user code area inside the r_sci5_callback_receiveend()

function:

static void r_sci5_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */
/* Check the contents of g_rx _char */
iIf (("c” == g_rx_char) || (°C" == g_rx_char))

g_adc_trigger = TRUE;
by

/* Set up SCI5 receive buffer and callback function again */
R_SC15_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

}

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI5_AsyncTransmit
Description : This function sends SCI5 data and waits for the transmit end flag.
Arguments - tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

ok X X X X Ok XN\

/
MD_STATUS R_SCI5_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci5_txdone = FALSE;

/* Send the data using the APlI */
status = R_SCI5_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci5_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI5_AsyncTransmit
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5.6.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk_debug.h"
Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX231 ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD_Start();
/* Set up SCI5 receive buffer and callback function */
R_SC15_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI5 operations */
R_SCI5_Start();
while (1U)
{
uintl6é_t adc_result;
/* Wait for user requested A/D conversion flag to be set */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count */
if (16 == ++adc_count)
{
adc_count = 0;
}
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
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/*

SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{
h
els
¥
H
/* End

}

/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_complete = FALSE;

e

/* do nothing */

user code. Do not edit comment generated here */

Then, add the following function definition in the user code area at the end of the file:

/

* Function Name : uart_display_adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8_t : adc_count

* uintl6_t: adc result

* Return value : none

static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)

/* Declare a temporary variable */

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: »xxH\r\n";

/* Convert ADC result into a character string, and store in the

ing to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < 0x0A) ? (a + 0x30)

a = (char)((adc_result & 0x0F00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30)

a = (char)((adc_result & 0Ox00F0) >> 4);

uvart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30)

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30)

the string to the UART */

R_DEBUG_Print(uart_buffer);

{
char a;
Cast
/* Send

b

- (a + 0x37));
: (a + 0x37));
: (a + 0x37));

: (a + 0x37));

local.

/

/

* End of function uart_display_adc

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
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The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI5 (see §4.4.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the via SCI5. Return to this point in the CG_Tutorial to add the LED user code.

5.7 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "rskrx23ldef.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSKRX231 ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Sart the A/D converter */
R_S12AD_Start();
/* Set up SCI5 receive buffer and callback function */
R_SCI15_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI5 operations */
R_SCI5_Start();
while (1U)
{
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set(SW1 or Sw2) */
if (TRUE == g_adc_trigger)
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
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}
/*

els

{

H
els

}

h
/* End
}

/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{

adc_count = 0;

led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
e if (TRUE == g_adc_complete)

/* Get the result of the A/D conversion */
R_S12AD_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{
adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

e

/* do nothing */

user code. Do not edit comment generated here */

Then, add the following function definition in the user code area at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument : uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8_t)((count & 0x01) ? LED_ON : LED OFF);
LED1 = (uint8_t)((count & 0x02) ? LED_ON : LED OFF);
LED2 = (uint8_t)((count & 0x04) ? LED_ON : LED OFF);
LED3 = (uint8_t)((count & 0x08) ? LED_ON : LED_OFF);
}
/
* End of function led_display_count
/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now

the LEDs wi

Il display the adc_count in binary form.
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6. Debugging the Project

e In the ‘Project Tree’ pane, right- | =.[& CG Tutorial (Project)* ]
click the ‘RX Simulator (Debug .38 RSF52318AxFP (Microcontroller)
Tool)'. Select ‘Using Debug . _ﬂCnde Generator (Design Tool) Siz
Tool -> RX E1(Serial)’. A, CC-RX (Build Toel) 4 En

-3 File Using Debug Tool  » || RX EL(Serial) |||:
; ﬂ Build tool generat) 75 Property RX E20(Serial) 1
r-| iodefine.h o
RX Simulator
I_E Code Generator S r-.:
I_E C Source Files H

e Double-click ‘RX E1(Serial) | 4 Internal ROMRAM
(Debug Tool)' to display the Size of internal F’Jl:IhT[biE‘-;tes‘: 512
debugger tool properties. of internal F?.Af-.ﬂ[F-.Egte-;__ . 64

f ) . Size of DataFlash memory[KBytes] 8
Under ‘Clock’, change the main 4 Clock
clock frequency to 8 MHz and I y— EXTAL
operating frequency to 54MHz. Main clock frequency[MHz] 8.0000

e Under ‘Connection with Target gl'l’erf“i:gf“?q“z“f{”'l*zlk e ':’I““m“
Board’, change ‘Power target . c::“;i;?,:fjmtecoc source on writing internal flash memory o
from the emulator.(MAX 200mA) Emulator serial No.
to ‘Yes’ 4 Connection with Target Board

e All other settings can remain at ‘a’f""““'“’"“'a’“’"(wzm"'m ;’

. upply voltage ¥
their defaults. Communications method FINE
FINE baud rate[bps] 2000000

e Connect the E1 to the PC and
the RSK E1 connector.
Connect the Pmod LCD to the
PMOD1 connector.

e From the ‘Debug’ menu select
‘Download’ to start the debug
session and download code to
the target.
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7. Running the Code Generator Tutorial

7.1 Running the Tutorial

Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

Once the program has been downloaded onto the RSK device, the program can be executed. @
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8. Additional Information

Technical Support

For details on how to use CS+, refer to the
help file by opening CS+, then selecting Help
> Help Contents from the menu bar.

sol Window | Help

Help

@

@+ Open Help for Start Panel

@q‘q One Point Advice...

Ll

2]
=

UEK

|E 3

Tutorial
Learn

About...

Browse Renesas Electronics Microcontrollers Web

Detail Version Information...

F1

For information about the RX231 group microcontroller refer to the RX231 Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 9 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:

http://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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